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Award Winning Bearly Bytes Newsletter  

Next Meeting AUG 10, 2010 at 5:30 @ The Discovery Center 

Bearly Bytes 

Big Bear Computer Club Volume 15 

 

Big Bear, California 

 

workshop are welcome to attend again. There is 

always more to absorb. 
 

Thanks to everyone who attended and to those 

who helped each other. Thanks to Barbara Moore 

for her assistance.  
 

The students were:   Maryann Boone,  Eileen 

Bryan,  Nancy Hinz,  Eileen McGants,  Dennis 

Pitner,  Donne Richiutti 
  

Feel free to contact me.  

Thanks!  Rosemary Lloyd     

909.584.9358 

Rosemary@BigBearCC.org    

 
 

 Big Bear Computer Club Workshops 2010  
 

On Monday, August 16, 2010 the Computer Club is 

sponsoring another workshop. The topic is again Win-

dows 7 Basics. It is designed for people who are new 

to Windows 7. Perhaps you recently purchased a new 

computer running the latest operating system. It is 

similar to Vista and looks very different from XP. 
 

We will cover desktop features, the Start Menu and 

Gadgets. Some of the new features like Aero Shake 

and Snap are cool ways to bring windows to the front 

or resize and compare windows. See updates to the 

Taskbar. Check out Documents, Computer and Con-

trol Panel, formerly known as My Documents, My 

Computer and Control Panel, respectively. All have 

new refinements. Of course, there is much moreé 
 

The location of the workshop is the Senior Center of 

Big Bear Valley. The time will be 10:00 AM until 2:00 

PM. We will break for about 30 minutes for lunch. 
 

Plan to bring a laptop, if you have one. If not, please 

let me know. We can provide one or two for the work-

shop. The requested donation for attending the work-

shop is $15 per person. That includes lunch at the 

Senior Center. 
 

If you are interested in assisting students by looking 

over their shoulder and helping them to ask questions, 

please let me know. That would be wonderful. 
 

The first workshop was well received. Everyone 

seemed to enjoy and learn. I know that I did. A num-

ber of people who wanted to attend could not make it 

in July. Since the interest seems to be there, we are 

doing Windows 7 again. Folks who attended the first  
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The following members have generously offered 

to help you with your PC problems by Phone or 

by email: 
 

Windows Beginners                   Yomar Cleary 

878-5622                      ycleary@charter.net 
 

Windows XP, Vista, 7              Rosemary 

Lloyd 

584 9358                 Rosemary@bigbearcc.org 
 

MS Outlook                           Rosemary Lloyd 

584 9358                 Rosemary@bigbearcc.org 
 

MS Excel                                Yomar Cleary 

878 5622                      ycleary@charter.net 
 

MS Publisher                                Yomar 

Cleary 

878 5622                     ycleary@charter.net 
 

Digital Photos                           Barbara Moore 

585 7981                        barbstuff@verizon.net 
 

CD Burning                           Rosemary Lloyd 

584 9358                  rosemary@bigbearcc.org 

  

Adobe Photoshop,                   Rick Edwards 

Photoshop Lightroom   

547-0109                     rick235@charter.net 
 

The Computer Club provides train-

ing at the monthly meetings when 

there is no presenter. Beginners 

are welcome. 2nd Tuesday of the 

month at the Discovery Center at 

5:30 pm. Bring a friend. Yearly 

dues are only $25, spouse is $5. 

First 2 visits are free!  

Helpline 

President ......................................Rosemary Lloyd 

584-9358                         rosemary@bigbearcc.org 

Vice President ééééééééé..Yomar Cleary 

878-5622                                 ycleary@charter.net 

Treasurer ........................................Barbara Moore 

585-7981                              barbstuff@verizon.net 

Secretaryééééééé.é..éé...Tina Nazarian 

633-4516                   Tina_Nazarian@hotmail.com 

Reviews Editor éééééé..ééé....Ron Fross 

951.769.1225                          rgfross@yahoo.com 

Refreshments éééééé... 

   

Publicity ............................................Yomar Cleary 

878-5622                                 ycleary@charter.net 

Equipment Director ...........................Don Odekirk 

585-6728                            djodekirk@hotmail.com 

Technical Director .................................Jim Lloyd 

584-9358                     inquiries@sugarloafpc.com 

Director at Large éééé..é..........Rick Edwards 

547-0109                                 rick235@charter.net 

Webmaster ........................................Bill Flanagan 

866-9379                                   bill@bigbearcc.org 

Newsletter Editor ..............................Eileen Bryan 

714.580.4784                    eileenbrn6@yahoo.com 
  

Membership Director éééé...é..Bill Flanagan 
866-9379                                   bill@bigbearcc.org 

Parliamentarian ............................David Philipson 

585-9389             philipson@philipsonerdmier.com 

Historian ..............................................Nancy Hinz 

585-8095                                   ncyhz@gmail.com 

Sunshine Coordinator ......................Grace Fross 

951.769.1225                         gcfross@yahoo.com 

Officers and Key Leaders 
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tǊŜǎƛŘŜƴǘΩǎ aŜǎǎŀƎŜ ς Rosemary Lloyd 

 

Hello Everyone 

Happy August! 

 

The Christmas in July potluck was fun.  The 
folks who attended seemed to enjoy the ex-
cellent food and good company. Yomar and 
Bobôs video of France was very cool. 

I enjoy talking computers and other tech sub-
jects. However, I also really enjoy time like we 
had at the July meeting.  There was talk of 
non-technical topics. Fellowship and friend-
ship help us to be well rounded, I think. I 
would like to perhaps plan more social gather-
ings for the club.  Just a thought. 

The Windows 7 Basics workshop went well.  
The students seemed to learn a lot. They 
even enjoyed some of it! There is a slot for 
another workshop in mid-August.  Please see 
my other article regarding the workshops. 

See you soon! 

 

Thanks. 

Rosemary Lloyd 

 

 

General Meeting Minutes ς  

Tina Nazarian 

 

(There were no minutes because we were cele-
brating Christmas in July with all the trimmings 
of turkey, ham mash potatoes and all the side 
dishes.  The best part was that everyone left the 
meeting with a Christmas gift provided by the 
The Big Bear Computer Club) 

 

MERRY CHRISTMAS 
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 ~ by Ira Wilsker 
 

I recently encountered a situation where one of my computers was unable to load a new beta (pre-

release) version of one of the popular security software suites that I was beta testing. The purpose of 

beta testing is to find serious bugs and other problems before the software is officially released.  I have 

been a beta tester for dozens of titles over the years, and am fully cognizant of the problems and risks of 

beta testing. While the  software publisher's beta support team has not yet resolved my issue, which was 

repeatable, this particular computer was now lacking any security software, and was at risk while per-

forming normal online and offline tasks. I could have reinstalled my previous security suite, which has 

proven itself as reliable and effective, but I decided that this would be a good opportunity to try some-

thing new. There are a lot of security utilities available, both commercial and free, so I decided to try one 

of the few free products that I had not tried on one of my personal computers. I decided to try Microsoft's 

Security Essentials. 

Microsoft had sold online and through retail channels its previous security product, Windows Live One-

Care, which was met with mixed reviews regarding its level of protection and performance. In late 2008 

Microsoft announced that it would discontinue Windows Live OneCare on June 30, 2009, and replace it 

with a new offering code named "Morro".  "Morro" was released in its final version in 2009 for free distri-

bution and download as Microsoft Security Essentials. This product is available for download directly 

from Microsoft at www.microsoft.com/Security_Essentials. As is common with almost all other Microsoft 

services, Microsoft will digitally determine the validity of the Windows installed on the computer before 

allowing the download; this process only takes a few seconds. Security Essentials will run on almost any 

Windows computer with a genuine copy of XP (Service Pack 2 or SP3), Vista (Service Pack 1 of SP2), or 

Windows 7. Versions are available for either 32 bit or 64 bit operating systems.   

Since Security Essentials is an integrated anti-malware product that protects from both viruses and spy-

ware, it will disable Windows Defender (Microsoft's dedicated anti-spyware utility) if Defender is already 

installed on the computer. Unlike other competitive security suites, Security Essentials does not include a 

firewall, but instead activates Window's integral firewall, and works with it.  Also, since this is an 

"Essentials" utility that only provides malware protection, it does not include most of the other enhance-

ments incorporated into the commercial products, such as anti-spam, website protection, and other 

tools. Security Essentials is ICSA Labs certified, and has been awarded the VB 100 Virus label, meaning 

that it detected 100% of the threats in a standardized testing environment. This is important as it indi-

cates that Security Essentials does an acceptable job in protecting systems from malware. 

Downloading Security Essentials directly from Microsoft was very fast, the 64 bit version only being 

about 7mb in size. Installing it was simple, but it did recognize that I had some other security software on 

the computer, and directed me to uninstall the other software before installing it. Once I uninstalled the 

other security software that it identified, Security Essentials installed very quickly, and did not present 

any complicated configuration questions. After installing the program, it asked to perform an update, and 

then completed a quick scan of my hard drive.  The scan was very fast, among the quickest that I have 

experienced, a plus for Security Essentials.  

The interface for Security Essentials is clean, with few options available. The "Home" screen shows if the 

real-time protection is on, and if the signature files are up to date.  Also on the Home screen are buttons 

for a quick, full or custom scan.  

Microsoft Security Essentials - Free Anti -Malware Protection  

     Continued on Page 5 

http://www.microsoft.com/Security_Essentials
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The "Update" screen shows the date and time that the definitions were created, as well as virus definition 

and spyware definition version numbers. The "History" screen shows threats that were detected, quaran-

tined, or allowed.   

Under the "Settings" tab, the screen shows the scheduled scans, file exclusions, some simple 

"Advanced" settings, and an ominous selection "Microsoft SpyNet". Microsoft SpyNet is an online com-

munity that helps the user respond to threats.  By default, Security Essentials sends basic information to 

Microsoft about any possible malware that was detected. One interesting statement on the SpyNet set-

ting says, "In some instances, personal information might unintentionally be sent to Microsoft.  Microsoft 

will not use this information to identify you or to contact you."  The "Advanced membership" is basically 

the same, but sends additional software information to Microsoft.   

One setting that is missing in Security Essentials that is on almost all other security products, is some 

type of setting to determine how often the software should "phone home" to check for updates. Microsoft 

says that it automatically updates, but does not indicate any standardized frequency of updates. My for-

mer security suite by default checked for updates every hour, and another product that I have used 

"pushes" almost continuous updates to the user, keeping them reasonable up to date. 

By contrast, Security Essentials has an apparently unpredictable update pattern, such that today I re-

ceived a warning on the task bar icon, which flashed red; clicking on the icon told me that my definition 

files (virus signature files) may be out of date. Looking at the "Update" tab on the program showed that 

my files were two days out of date, so I manually updated the software by clicking on the "update" but-

ton. The update was quickly downloaded and installed, but it was interesting to note that the time stamp 

on the latest update was about six hours old.  

As I type this, the "Update" screen shows that my definitions are over 10 hours old, so I just clicked on 

the update button again; Security essentials duly checked for an update, and reported that my software 

is up to date, but still shows the 10 hour old definitions as being the latest. Several years ago, daily up-

dates were the industry norm, but today, with thousands of new threats appearing daily, infrequent up-

dates may indicate a potential weakness in system defenses, as competitive software would have al-

ready been updated several times today. 

One very pleasant surprise with Security Essentials is how fast it loads at boot, and how little it degrades 

system performance.  I use a software utility called Soluto to monitor and control my boot process; using 

my prior security suite, boot time was about 100 seconds, but with Security Essentials, my computer is 

booting in about 50 seconds, or twice as fast!  Likewise, programs seem to load much faster with Secu-

rity Essentials than my previous product, and browser performance is greatly improved as well, with web 

pages loading much faster. This may be explained by the fact that since Security Essentials is precisely 

what its name implies, only the basic essentials load;  other overhead is not loading and running like the 

more comprehensive competitive security suites. 

It is up to the user to decide if the minimal but adequate protection provided by the free Microsoft Secu-

rity Essentials is worth the significant improvements in performance that it allows. Since my personal 

choice is to have increased protection, even at the cost of some performance degradation, I will go back 

to my favorite comprehensive commercial suite as soon as the beta issues are resolved, or the final ver-

sion is released.  Still, in the meantime, I will stay with Microsoft Security Essentials until that time. 

Website: www.microsoft.com/Security_Essentials 

Continued from Page 4 

http://www.microsoft.com/Security_Essentials
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    10 General  Meeting  

    31 Board Meeting  

     16  General  Meeting  

     30 Board Meeting  

SEPTEMBER 

S M O T W T H F R S A

   1  2  3  4 

5 6 7 8  9 10 11 

14 15 16 17 18 19 20 

21 22 23 24 22 26 27 

28 29 30     

AUGUST 

S U M O T W T H F S A

 1  2  3  4  5  6  7 

 8  9 10 11 12 13 14 

15 16 17 18 19 20 21 

22 23 24 25 26 27 28 

29 30 31     

www. techbargains .com  

web site devoted to helping users find the best 

technology products and the lowest price  

 

Beginning Bank  $3,155.30  

Cash Received  

Membership Dues    0.00 

Fundraising Equipment  90.00  

Donations: 50/50  22.50 

Donations 0.00 

Advertising 0.00 

Other Income 0.00 

Total Income         $125.00  
 

Cash Disbursed  

Dues & Fees  0.00 

Advertising 450.00 

Promotion  27.67  

Equipment 0.00 

Supplies 0.00 

Total Paid Out  $477.67  
 

 

Ending Balance in Bank  $2,802.63  

Cash Flow  July, 2010  

 
 

   COMPUTER LINKS  

  

http://etricks.in/ 

http://www.newhorizonsetips.com/nhtips.asp    

http://www.computerhope.com/support.htm 

 MICROSOFT TIP  

Now you can search your Favorites by typing 

keywords into the address bar in IE8. If it doesn't 

work for you, make sure you have the latest ver-

sion of Windows Desktop Search installed.  

http://www.techbargains.com
http://etricks.in/
http://www.newhorizonsetips.com/nhtips.asp
http://www.computerhope.com/support.htm
http://www.crawlersmileys.com/?d=1&src=wms&tbid=60071&sm=Cool%20smiley:9617&
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When Microsoft Word calculates line length and wraps text to the next line, it tries to wrap (or break) the line 
at a space or a hyphenða dash. Sometimes, however, you may not want Word to break a line at a dash. 
For instance, dashes are used in telephone numbers, and you might not want a line to break in the middle of 
a telephone number. 

The answer is to use non-breaking hyphens instead of regular dashes when you don't want Word to break a 
line at the hyphen. To do this, hold down the CTRL and SHIFT keys as you type the dash (this is the same as 

typing CTRL and an underscore). Word will then not break the line at that point. 

You can also insert a non-breaking hyphen by following these steps: 

1. Choose Symbol from the Insert menu or, in Word 2007, display the Insert tab of the ribbon, click 
Symbol in the Symbols group, and finally click More Symbols. This displays the Insert Symbol dia-
log box. 

 

2. Click on the Special Characters tab. 

 

The Special Characters tab of the Symbol dialog box. 

 

3. Highlight the Non-breaking Hyphen character. 
 

4.  Click on Insert. 
 

5. Close the dialog box by clicking on Cancel. 

 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission.  
 

You can find thousands of free Microsoft Word tips online at http://word.tips.net  

INSERTING A NON-BREAKING HYPHEN 
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By: Yomar Cleary 

For those of you who knew Larry Smith, 

he passed away on June 13
th
 after an ex-

tended illness. He and his wife Kathy 

Smith joined the Big Bear Computer Club 

when the club was in its infancy and 

helped develop into what it is now.  

Larry took care of the Clubôs equipment; 

he was the ñgo-toò person who was re-

sponsible for keeping the equipment in 

good working order. In the last couple of 

years, he would research articles for the 

Bearly Bytes Newsletter. Larry was an 

avid HAM radio operator.  He will be 

missed. 

May he rest in peace! 

LARRY  SMITH LARRY  SMITH LARRY  SMITH ïïï   LONG TIME LONG TIME LONG TIME 

COMPUTER MEMBERCOMPUTER MEMBERCOMPUTER MEMBER   

About Bearly Bytes  

Bearly Bytes , past winner of SWUGC & 

APCUG Newsletter contests is the official 

publication of the Big Bear Computer Club. 

Views expressed in Bearly Bytes are those 

of the authors and do not necessarily reflect 

the opinions of Big Bear Computer Club. 

Other computer user groups are welcome to 

reprint our articles as long as they give 

credit to the author and Bearly Bytes, Big 

Bear Computer Club. 

Submissions: All BBCC members are en-

couraged to send letters, articles, questions, 

and comments to Bearly Bytes for inclusion 

in future issues. Submit as plain text in the 

body of an email and attach any graphics as 

JPEG or GIF format. Send to Yomar Cleary 

 

 

 

 

Perform- ance 

Management Software  

866-566-7778 

DISCONTINUING REFRESHMENTS AT THE 

MEETINGS 

Since no one has stepped up to be Refresh-

ment Chairperson we will discontinue the 

refreshment portion of the meeting starting 

at the August 10th meeting.   

What is involve is providing paper plates, 

napkins, bottled water, soda, and forks.  The 

club provides the funds for these items. The 

membership brings goodies to share.  If in-

terested contact Yomar Cleary (909) 878 -

5622. 

http://www.halogensoftware.com/
http://www.memoryamerica.com/
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         Indenting Cell Contents  
Microsoft Excel allows you to format the contents of a cell in a myriad of ways. One of the formatting options you can 

apply is to indent the contents of a cell by a certain amount. This is similar to indenting done in a word processor, such 

as Microsoft Word, except that the indenting is specified in a number of characters, not in a linear distance such as 

inches or points. 

To set the indent to be used in a cell, follow these steps: 

1. Select the cells you want to format. 

2. Display the Format Cells dialog box. (In Excel 2007 display the Home tab of the ribbon and click the small 

icon at the lower-right corner of the Number group. In older versions of Excel choose Cells from the Format 

menu.) 

3. Make sure the Alignment tab is selected. 

 

The Alignment tab of the Format Cells dialog box. 

4. In the Horizontal drop-down list, choose Left (Indent). If you are using Excel 2002 or a later version, you can 

also choose Right (Indent). 

5. Using the Indent control, specify the number of characters by which the cell contents should be indented 

from either the left or right side of the cell. You can pick any whole number between 0 and 15. 

6. Click on OK. 

         Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission.  
Thousands of free Microsoft Excel tips can be found online at  
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May 24, 2010 

 

Ms. Rosemary Lloyd 
Big Bear Computer Club 
P. O. Box 745 
Big Bear City, CA 92314 
 

Dear Ms. Lloyd: 

RE: P. A. System for Big Bear Discovery Center 

 

On behalf of the San Bernardino National Forest Association (SBNFA) Board and staff, we wish 

to thank you for your generous donation of a $1,100.00 public Address System to be used at the Big Bear  

Discovery Center. 
 

This P.A. System will be used extensively at our meetings and outside events - something we have needed for 

some time, but funding was not available to purchase the system ourselves.  
 

Please extend our sincere appreciation to your board and members for such a generous gift. 
 

We hope you will continue to use the Big Bear Discovery Center facility for your monthly meetings and if  

you have a need for this public address system, please let us know ahead of time so we can have it available 

for you. 
 

Sincerely,  

SMiggins    
Sarah Miggins 
Executive Director 
San Bernardino National Forest Association 

 
 
 

602 S. Tippecanoe Avenue S̷an Bernardino, CA T̷el (909) 382-2796  ̷Fax (909) 866-1781 www.sbnfo.org 

 
  
 

USER GROUP COUPON CODE - Peachpit  
We provide your group members with a 35% discount off the list price of any of our books. At 
checkout, right before entering their credit card information, they must enter the user group cou-
pon code UE-23AA-PEUF (case-sensitive). This coupon code is an exclusive offer that may not 
be used in conjunction with any other coupon codes.   www.peachpit.com 

The Abacus Group  

For All Your Computer Needs 
  

Jim Applebury  

909 584-1733  

http://www.sbnfo.org
http://www.offers.com/
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Word Tip  

By  Rosemary Lloyd 

Excel Tip  

By Yomar Cleary 

Windows  Tip 

By Barbara  Moore 

 

Displaying the Full Ribbon 
 

Kamal notes that half of the ribbon in 

Word is concealed. Every time he has to 
do something like change font, font size, 
underline, italicize, etc., Kamal has to 
click Home for the full ribbon to appear, 
do the task, and then the full ribbon gets 
concealed again. He wonders how to get 
the full ribbon to remain visible at all 
times. 
 

This is a common occurrence in Word. 
The ribbon can either be fully displayed 
or it can be minimized when not in use. 
The condition that Kamal describes is for 
a ribbon that is minimized. You can 
switch the ribbon back to a normal, full 
display by using any of these techniques: 
 

¶ Double-click any ribbon tab. 

¶ Press Ctrl+F1 . 

¶ Right-click any ribbon tab and clear 

the check mark beside the Minimize the 
Ribbon option. 
 

Click the small downward-pointing arrow 
at the right end of the ribbon. As you can 
tell, there are many ways that Word pro-
vides to accomplish the same task. For 
most people, it is the first method (double 
clicking) that causes the problem in the 
first place. It is easy to double-click a rib-
bon tab without even realizing it, and 
then your ribbon is hidden without under-
standing why.  

WordTips is your source for cost-
effective Microsoft Word training. 
(Microsoft Word is the most popular word 
processing software in the world.) This 
tip (8376) applies to MS Word versions: 
2007 | 2010 More tips can be found at: 
http://word.tips.net   

Add a drop-down list to an Excel 
cell   
 

 Drop-down lists can greatly facili-
tate data entry and create handy 
lists within your worksheets. The 
following sheet shows a simple drop
-down list in an Excel sheet. 
 Clicking the drop-down arrow dis-
plays a list of items from a1:a4. If 
you try to enter something that isnôt 
in the list, Excel rejects the entry. 
To add this drop-down list to a 
sheet, do the following: 
Create the list in cells a1:a4. Simi-

larly, you can enter the items in a 
single row, such as a1:d4.  
Select cell e3. (you can position 

the drop-down list in most any cell 
or even multiple cells.)  
Choose validation from the data 

menu.  ð Choose list from the al-
low optionôs drop-down list. (see, 
theyôre everywhere.) ð Click the 
source control and drag to highlight 
the cells a1:a4. Alternately, simply 
enter the reference (=$a$1:$a$4).  
Make sure the in-cell dropdown 

option is checked. If you uncheck 
this option, excel still forces users 
to enter only list values (a1:a4), but 
it wonôt present a drop-down list.  

Click ok.  
You can add the drop-down list to 

multiple cells. Select the range of 

data input cells (step 2) instead 

of a single cell. It even works for 

noncontiguous cells. Hold down 

the shift key while you click the 

appropriate cells. Itôs worth not-

ing that the drop-down arrow is 

visible only when the cell is ac-

tive.   

 

Add RUN to the Start Menu.  

This feature gives needed ac-
cess to many functions in Win-
dows  so why keep it hidden 4 
clicks deep  in the All Pro-
grams menu? Put it back.    

Right click the Start menu 
and select Properties/
Customize/Scroll down  and 
put a check in the RUN box/

OK/OK . 

That's it. The next time you 
want access RUN without hit-
ting the Windows Key + R, it's 
right there for you where it was 
in XP and where it's easy to 
access.  

The file search options is cum-
bersome. How can you point to 
where it is if you are looking for 
it?  If you knew where it was, 
you wouldn't be searching.  

What if you don't want to use 
filters? How about just finding a 
file? 

Heading to the king of all 
searches, Google, look for, 
ñEverything.ò   "Everything" is 
just what Windows 7 needs. 
Simply type in the item to find 
and BINGO, No more clicking, 
and shuffling folders. 

Download it, put it on your 
desktop, problem solved. It's 
quick, lite, and finds... every-
thing.  

User Code DSUG when ordering online or by phone: 800.998.9938 

http://www.cheapstingybargainsl.com/
http://wordribbon.tips.net/Pages/T008376_Displaying_the_Full_Ribbon.html
http://wordribbon.tips.net/Pages/T008376_Displaying_the_Full_Ribbon.html
http://word.tips.net
http://ct.techrepublic.com.com/clicks?t=544770313-6155f939b8ad382bb0373be8654ce5c7-bf&brand=TECHREPUBLIC&s=5
http://ct.techrepublic.com.com/clicks?t=544770313-6155f939b8ad382bb0373be8654ce5c7-bf&brand=TECHREPUBLIC&s=5
http://www.voidtools.com/download.php%20%20
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            �7�K�L�V���0�R�Q�W�K�¶�V���'�R�R�U���3�U�L�]�H���:�L�Q�Q�H�U�V��            Christmas in July Door Prizes  

Everyone who attended received a prize!  

 

Christmas in July was the theme for last month's General Membership Meeting.  Attendance 
was up slightly with almost 30 members and their guests there for the evening.   

Yomar Cleary started the evening off with the entertainment: a wonderful DVD of her trip 
through France. The movie was approximately one hour long and covered the whole of 
France. Small towns and big towns, art and architecture, food and wine, the movie covered it 
all.   

The entertainment was accompanied by the food portion of the evening.  Ham, turkey, and 
chicken were the main entrees; twice-baked mashed potatoes, broccoli salad, green beans 
and green salads were also present.   

And let's not forget the desserts. Yum.  Everyone was able to fill their plates at least once 
and I think it is safe to say that no one left the meeting hungry.  

Barbara Moore really stepped up with the gifts she selected. The gifts ranged from a lap-
desk, to USB extended ports, to software programs and T-shirts.  Everyone received some-
thing and all seemed happy with their selection.    


